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Julkaisun ulottuvuudet 
Formaatti

Taitto

Typografia

Kuvankäsittely, valokuvat

Piirrokset, kaaviot, infografiikka



			   Tavoite	 Suunnitteluväline	 Haaste
	
Formaatti, eli sivukoko, sidosasu.		  Luettavuuden ja 	 Havinnollinen	 Käsiteltävyys 
			   kirjan muodon 	 fyysinen malli.	 vs.
			   yhteensopivuus.		  kertovuus

Taitto, eli tekstin ja kuvamateriaalin sommittelu.	 Sisältöjen 	 Word, InDesign,	 Materiaali
			   keskinäisten	 Quark	 vs.
			   suhteiden hallinta.		  kokonaisuus

Typografia, eli kirjasintyypit ja niiden käyttö.		  Sanallisen tiedon	 Word, InDesign,	 Selkeys
			   välittäminen.	 Quark	 vs.
					     ilmaisu

Kuvankäsittely, eli kuvatiedoston muokkaus.		  Kuvallisen tiedon	 Photoshop	 Sisältö
			   välittäminen.		  vs.
					     tila

Piirrokset, kaaviot, eli teknisten piirrosten laadinta.	 Kertovuus ja	 InDesign,  	 Prioriteetit
			   tarkkuus	 Illustrator	 vs.
					     tekniikka



Formaatti 



Julkaisun merkittävimpiä ominaisuuksia on sivukoko, joka usein määrittyy standardien mukaan.

ISO A standardin mukaiset paperikoot

 									         A  						     B 					     C 

							       0 		  841 × 1189 			   1000 × 1414 		  917 × 1297

							       1 		  594 × 841 			   707 × 1000 		  648 × 917 

							       2 		  420 × 594 			   500 × 707 		  458 × 648 	

							       3 		  297 × 420 			   353 × 500 		  324 × 458 

							       4 		  210 × 297 			   250 × 353 		  229 × 324 	

							       5 		  148 × 210 			   176 × 250 		  162 × 229 	

							       6 		  105 × 148 			   125 × 176 			  114 × 162 	

							       7 		  74 × 105 				    88 × 125 			   81 × 114 



Julkaisu painetaan irtolehtinä tai suurina arkkeina (esim. A-kokoinen julkaisu B-kokoisille arkeille), 

jotka sitten taitellaan vihkoksi, vihkot sidotaan ja sivut leikataan sopivaan kokoon. 

Sidonnan tapoja on useita, tyypillisimmät:

Stiftaus		  julkaisu taitetaan auki ja niitataan 2-3 niitillä vihkoksi

Liimaselkä	 julkaisun selkäpuolen sivut rouhitaan karheiksi ja liimataan kuumaliimalla selkämykseen

Liimalanka	 julkaisun sivut sidotaan vihkoina, jotka liimataan selkämykseen

Sidonta		  jukaisun sivut sidotaan vihkoina, jotka vielä sidotaan yhteen

Kierreselkä	 julkaisu on puhtaaksi leikattu vihko, jonka selkänä toimii metalli- tai muovikierre



 

 

Sidonnan valinnan perusteena usein sisällön ominaisuudet ja kestävyys:

Stiftaus		  hyvä suppealle julkaisulle, sivuja n.8-32

Liimaselkä	 helppo sidonta, iän myötä haurastuu ja sivut irtoavat, aukeamat avautuvat jäykästi

Liimalanka	 hyvä yleissidonta julkaisulle, pääosin kirjapainojen toteuttama (ei tulostuslaitoksessa)

Sidonta		  klassinen kirjan sidontamalli

Kierreselkä	 helppo sidonta, aukeamat avautuvat täysin

Sidonta



 

 

Paperin valinnan perusteena tulee olla sisällön vaatimukset ja käyttökokemus:

Paino			   Kopiokoneissa käytettävät 80-120g/m2* paperit tyypillisiä ja soveltuvia moneen, mutta 

				    raskaampia ja kevyempiä voidaan tarpeen mukaan määritellä. Yli 170g/m2 paperi murtuu 

				    taitettaessa, jollei sitä nuutata** ensin. Paperilla on yleensä tietty suuntaus - sen kuidut ovat 

				    pääosin yhteen suuntaan - tämä vaikuttaa myös sen käyttäytymiseen taitettaessa.   

				    *	 Yksikkö neliömassa = yhden paperineliömetrin paino grammoina

				    **	 Nuuttaus = puristamalla tehty ura, yleensä konnellisesti tehty, voi tehdä myös käsin

Paperi



 

 

 

Pintakäsittely	Tyypillisesti paperi päällystämätöntä (UWF = Uncoated Wood Free),

				    päällystettyä paperia (CWF = Coated Wood Free) voidaan käyttää, jos halutaan saada 

				    hyvä kuvien laatu, etenkin värien toiston kannalta. Pintakäsittely vaikuttaa painotuotteeessa

				    käytettäviin väriprofiileihin.*

Opasiteetti	 Paperin läpinäkyvyys.   

				    *	 Väriprofiili määritellään kuville esim. Photoshopissa - väriprofiili sovitaan käytettävän 

					     paperin ja painettavan materiaalin mukaan painon kanssa etukäteen.

Paperi



Taitto



Julkaisun taitto tarkoittaa sen erilaisten sisältöjen - tekstin, kuvien, piirrosten, jne. - sovittamista sivulle 

ja niiden keskinäisten suhteiden määrittelemistä. Yleensä tämä tehdään jollakin systemaattisella, 

toistuvalla tavalla, kuten käyttämällä apuviivoja (guides) ja määrittämällä palstajako, palstojen (columns) 

määrän ja välien leveyden (gutter) avulla, samalla tavallisesti määritellään julkaisun sivujen marginaalit. 

Kokonaisuutta kutsutaan usein ‘gridiksi’ - joka kuitenkin on harvoin homogeeninen ja useimmiten ‘tartan’-

kuvion kaltainen.

Taiton haasteena on löytää sopiva suhde yksittäisten osasten ja kokonaisuuden välille - suurimmassa 

osassa julkaisuja toistuva järjestelmä auttaa lukijaa ja tekee sisällöstä ymmärrettävää. Taitto esimerkiksi 

kertoo lukijalla erilaisten tekstisisältöjen keskinäisestä hierarkiasta (teksti ja kuvatekstit, alaviitteet, jne). 

Järjestelmän on kuitenkin kyettävä soveltumaan kaikentyyppiseen sisältöön, ilman runsaita poikkeuksia 

ja poikkeuksien poikkeuksia. 



Marginaali, ulko

Leikkausvara 
3mm

Marginaali, ylä

Marginaali, ala

Kuva-alue

Marginaali, sisä

Palstaväli

Apuviivat

Taite

Palsta 1. Palsta 2. Palsta 3. Palsta 4.

Kuva-alue

 

 

 

Marginaalit	 etenkin sisämarginaalin riittävyys on tarkistettava suhteessa sidosasuun.

Palstaleveys	 valitaan suhteessa valittuun tekstityyppiin ja kokoon. Yleisesti suhteellisen lyhyet palstat 

				    miellyttäviä lukea (n.10cm).

Palstaväli		  on oltava selkeä suhde kirjain- ja sanaväleihin - palstaväli ei saa olla pienempi kuin sanaväli.

Leikkausvara	 jos kuvat menevät sivun reunaan asti, niin tarvitaan 3mm leikkausvara (Bleed) - eli kuva 

				    viedään 3mm ‘reunan yli’ ja näin sivujen puhtaaksileikkauksessa reunaan ei jää näkyviin 

				    paperikaistaa.



Lorem ipsum dolor sit amet, consectetur adipiscing elit. Donec id blandit leo, 
a facilisis augue. Sed aliquam risus non lorem feugiat consequat. Donec euismod 
lacus vitae felis auctor interdum. In vulputate, tortor non aliquet tincidunt, libero 
est commodo urna, in maximus justo risus sagittis libero. Fusce eleifend neque at 
sagittis posuere. Mauris a laoreet dolor, vel lacinia dolor. Sed neque sem, maximus 
vel congue sed, rutrum et sapien. Nunc consequat est id ex ultricies, sit amet 
interdum diam lobortis.

Nam feugiat dolor a facilisis aliquam. Suspendisse dapibus augue vitae placerat 
commodo. Etiam at tortor non leo rhoncus laoreet non accumsan magna. Donec 
gravida ultrices nulla et pellentesque. Pellentesque nulla magna, finibus at orci 
at, ullamcorper maximus turpis. Nunc non volutpat nibh. Cras tincidunt placerat 

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Donec id blandit leo, a 
facilisis augue. Sed aliquam risus non lorem feugiat consequat. Donec euismod 
lacus vitae felis auctor interdum. In vulputate, tortor non aliquet tincidunt, libero 
est commodo urna, in maximus justo risus sagittis libero. Fusce eleifend neque 
at sagittis posuere. Mauris a laoreet dolor, vel lacinia dolor. Sed neque sem, 
maximus vel congue sed, rutrum et sapien. Nunc consequat est id ex ultricies, sit 
amet interdum diam lobortis.

Nam feugiat dolor a facilisis aliquam. Suspendisse dapibus augue vitae placerat 
commodo. Etiam at tortor non leo rhoncus laoreet non accumsan magna. Donec 
gravida ultrices nulla et pellentesque. Pellentesque nulla magna, finibus at orci 
at, ullamcorper maximus turpis. Nunc non volutpat nibh. Cras tincidunt placerat 

 

 

 

Sisennykset	 Sisennyksillä voidaan erottaa kappaleet toisistaan ilman ylimääräistä rivinvaihtoa, sisennyksillä 

				    voidaan myös luoda eroja ja hierarkioida tekstimassaan, esim. päätekstin ja lainausten välille. 

				    Ensimmäisessä esimerkissä yllä on 20 pikselin ensimmäisen rivin sisennys (‘First Line Indent’)

				    ja toisessa on kappaleita kaikkiaan sisennetty 20 pikseliä (‘Left Indent’) ja annettu ensimmäisen 

				    rivin sisennykselle arvo -20 pikseliä. 



 

 

 

Tasaus		  Tekstin tasaus on tyypillisesti vasempaan palstan reunaan, liehuvalla oikealla reunalla; näin 

				    kirjaimet saavat ‘luonnollisen’ määrän tilaa ympärilleen, ja sanavälit eivät veny tai kutistu 

				    haittaavasti. Muita tyypillisiä tasauksia ovat keskilinjaan tasaus kahdella liehuvalla reunalla - 

				    usein käytetty esimerkiksi otsikkosivuilla - ja tasaus oikeaan reunaan - esimerkiksi kun halutaan 

				    ankkuroida sivunumero tiettyyn linjaan. Pakotetuissa tasauksissa (‘tasapalsta’) voidaan tehdä 

				    tekstipalstoista tasareunaisia, mutta samalla voi syntyä liian suuria välejä sanoille tai kirjaimille. 

				    Etenkin pitkäsanaisessa suomenkielisessä tekstissä tämä on riskinä, jos tasattava palsta 

				    sisältää lähtökohtaisesti vähän merkkejä. Yllä ensimmäisessä esimerkissä tasaus ei haittaa, 

				    toisen esimerkin palstassa taas syntyy sanavälejä, jotka ovat jopa rivivälejä suurempia.

Lorem ipsum dolor sit amet, consectetur adipiscing elit. 
Donec id blandit leo, a facilisis augue. Sed aliquam risus non 
lorem feugiat consequat. Donec euismod lacus vitae felis 
auctor interdum. In vulputate, tortor non aliquet tincidunt, 
libero est commodo urna, in maximus justo risus sagittis 
libero. Fusce eleifend neque at sagittis posuere. Mauris a 

Lorem ipsum dolor sit amet, 
consectetur adipiscing elit. Donec 
id blandit leo, a facilisis augue. Sed 
aliquam risus non lorem feugiat 



 

 

 

Lesket			  Tekstin juoksutuksessa palstalta toiselle on hyvä välttää niinsanotuja ‘leskiä’ ja ‘orpoja’. Leski 

				    on edelliselle palstalle, pahimmassa tapauksessa myös edelliselle sivulle, jäänyt kappaleen 

				    ensimmäinen rivi. Yllä osoitettu sinisellä värillä. 

Orvot			   Orpo on seuraavalle palstalle tai sivulle joutunut kappaleen viimeinen rivi. Yllä osoitettu 

				    punaisella.

Lorem ipsum dolor sit amet, 
consectetur adipiscing elit. Donec id 
blandit leo, a facilisis augue. Sed aliquam 
risus non lorem feugiat consequat. 
Donec euismod lacus vitae felis auctor 
interdum. In vulputate, tortor non 
aliquet tincidunt, libero est commodo 
urna, in maximus justo risus sagittis 
libero. Fusce eleifend neque at sagittis 
posuere. Mauris a laoreet dolor, vel 
lacinia dolor. Sed neque sem, maximus 
vel congue sed, rutrum et sapien. Nunc 
consequat est id ex ultricies, sit amet 

interdum diam lobortis.
Nam feugiat dolor a facilisis 

aliquam. Suspendisse dapibus augue 
vitae placerat commodo. Etiam at 
tortor non leo rhoncus laoreet non 
accumsan magna. Donec gravida 
ultrices nulla et pellentesque. 
Pellentesque nulla magna, finibus 
at orci at, ullamcorper maximus 
turpis. Nunc non volutpat nibh. Cras 
tincidunt placerat neque at feugiat. 
Maecenas placerat lobortis erat nec 
malesuada. Maecenas tincidunt ac urna 

ut consequat. Pellentesque habitant 
morbi tristique senectus et netus et 
malesuada fames ac turpis egestas. 
Nulla condimentum quam non dui 
sollicitudin, sed hendrerit magna 
viverra. Maecenas fermentum, nisi ac 
ultrices condimentum, neque augue 
rutrum sapien, quis varius urna arcu 
sed dolor. Fusce congue justo id lectus 
feugiat, vel tincidunt metus rutrum. 
Vivamus lobortis nisl ac dapibus 
imperdiet. Integer et commodo orci.

Fusce dolor nibh, imperdiet feugiat 

ipsum ac, suscipit pretium arcu. 
Suspendisse laoreet, urna id commodo 
feugiat, mauris arcu ullamcorper quam, 
eu aliquet nunc urna imperdiet orci. 
Quisque ac commodo urna. Cras sed 
leo feugiat, mattis odio at, varius ante. 
Phasellus maximus odio sollicitudin 
arcu hendrerit, rutrum eleifend nunc 
consequat. Mauris viverra tortor non 
mauris malesuada, sit amet tempus 
libero lobortis. Phasellus dapibus 
non urna sed facilisis. Ut augue urna, 
consequat consequat nibh vitae, 



108

1980-luvuilla, oli rakentaminen pienimuotoista ja ympäristöönsä sopeutuvaa. Tämä ei johtunut 
ainoastaan paikan hengestä, sillä henkinen ilmapiiri oli alkanut muuttua muuallakin. Sen todis-
teeksi Suomi rakentaa 6 -näyttelyssä puhuttiin vuonna 1981 aluerakentamissopimusten ja tontti-
tehokkuuksien sijasta ympäristöarvoista ja arkkitehtonisesta laadusta.65

Järjestelmistä runouteen
”Tontin asemakaavalliseen ja arkkitehtoniseen ratkaisuun vaikutti oleellisimmin tonttia ympäröivä vanha 
rakennuskanta, westendiläiset yhdenperheen funkishenkiset huvilat. – – Asukkaiden omatoimisuuden ansi-
osta pihat muuttuivat jo ensimmäisenä kesänä reheviksi puutarhoiksi.” 66

Mutkia suoraksi oikoen voi sanoa, että Suomen ”asunto-ongelma” saatiin määrällisesti rat-
kaistua 1970-luvun aikana ja 1980-luvulle tultaessa oli vihdoin varaa pohdiskella laadullisia 
asioita. Suurimpien lähiöiden yksioikoinen, mittakaavaltaan karkea ja osin heikkolaatuinenkin 
asuinympäristö oli herättänyt vastustusta jo jonkin aikaa, eikä pelkkä katto pään päällä enää 
riittänyt. Valtaosalla suomalaisista oli vihdoin sisävessa, jääkaappi ja muovimatolla päällystetty-
jä asuinhuoneita keskimäärin vajaat 30 m² asukasta kohden. Huoneistosaunakin oli jo melkein 
kolmasosassa asuntoja.67 

Vuosikymmenellä rakennettiin 500.000 asuntoa eli lähes yhtä paljon kuin 1970-luvulla, 
mutta painopiste siirtyi lähiöistä ja aluerakentamisesta enemmänkin pientaloihin ja täydennys-

Liinasaarenkuja heti valmistumisen jälkeisenä kesänä AM/R
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asuinalueille. Ajattelutavan muutos siirtyi viralliseen ajatteluun ensin 1976–1985 valtakun-
nallisessa asunto-ohjelmassa ja lopulta vuoden 1979 Arava-ohjeissa, jotka ohjasivat asuntojen 
suunnittelua: niissä edellytettiin rakennusten suunnittelussa mittasuhteiden ihmisläheisyyttä, 
virikkeisyyttä ja sopeutumista ympäristöön.68 Jopa Suomen suurimman rakennusliikkeen raken-
nuskunta Hakan johtaja Antti Pelkola myönsi vuoden 1979 valtakunnallisilla asuntopäivillä, että 
rakentamisen kritiikki on perusteltua, sillä määrälliset tavoitteet olivat ajaneet laadullisten yli.69

Haka päätyikin muutamaa vuotta myöhemmin rakentamaan pikkuhuviloita Westendiin 
arkkitehti Erkki Kairamon suunnitelmien mukaisesti. Hiukan aikaisemmin Haka oli järjestänyt 
läheisestä Westendin korttelista arkkitehtuurikilpailun, jonka voitti arkkitehti Tuomo Siitonen 
uudentyyppisellä pientalon ja kerrostalon etuja yhdistelevällä rakennuksella.70 Samoin kuin Lii-
nasaarenkujalla, oli ehdotuksessa korostettu kuistien, viherhuoneiden ja ulkotilojen merkitystä 
asumiselle ja ulkoiselle ilmeelle. Rakennusta ei koskaan toteutettu, mutta sen esimerkkivoima 
raikasti asuntoarkkitehtuuria merkittävästi.

Liinasaarenkujan ensimmäisissä luonnoksissa näkyy selkeästi mielikuva funkishuvilasta, jonka 
eteen ja ylle levittäytyvät ekspressiiviset kuistit, parvekkeet ja laaja kattoterassi. Kattoterassille 
on ripustettu pyykkiä kuivumaan. Suunnittelun edetessä rakennukset kuitenkin hioutuivat luon-
nosvaiheen rivitaloista pelkistetyiksi identtisiksi täyselementtirakenteisiksi kuutioiksi, joiden 
tilamitoitus on niukan tehokasta. Tilat ja ikkunat ovat pienempiä kuin energiakriisiä edeltävissä 

Liinasaarenkuja heti valmistumisen jälkeisenä kesänä AM/R

Sanna Meriläinen: Tavallisia koteja, 2016.
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Sahanmäki, Mirja, 2h+k+parvi 76,5 m²

”Taidan olla oikea asukas tähän asuntoon. Muutimme tänne 1978 

Rajametsäntie 33:sta, kun lapset alkoivat tarvita omia huonei-

ta. Kolmen huoneen asunto tuntui kaksion jälkeen ihanan väljältä 

ja valoisalta, varsinkin kun olohuone on tavallista korkeampi. 

Edellisellä asukkaalla oli flyygeli tässä keskellä olohuonetta. 

Poika ja tytär saivat omat huoneet ja meidän vanhempien vuode-

sohva oli olohuoneessa parviportaan alla. Kattoterassi pyykin-

kuivausta varten oli tuossa vieressä. Poikani oli jo nuorena 

kiinnostunut tähtitieteestä ja istui iltaisin usein siellä kau-

koputkensa kanssa. Jossain vaiheessa kattoterassit kuitenkin 

rakennettiin umpeen ullakkotiloiksi, terassi taisi vuotaa. 

Koko talo remontoitiin 1994, ja silloin korvattiin kylpy-

ammeet suihkuilla, uusittiin parvekkeet ja keittiöt sekä maa-

lattiin kaikki pinnat. Huonosti, koska katosta maali irtoilee. 

Tuon porraskaiteen punotun köydenkin remonttimiehet olivat 

poistaneet, mutta minä vaadin että se on laitettava takaisin 

juuri samanlaisena. 

47

On täällä puutteitakin; keittiö ja eteinen tuntuvat vähän 

ahtailta, eikä keittiössä mahdu kunnolla leipomaan. Myöskään 

hissiä taloon on lähes mahdotonta saada, kun kaikki asunnot 

ovat eri tasoilla. Tätä porrashuonetta kävi hissiasiamies kol-

legoineen ihmettelemässä useaan otteeseen, mutta hissejä ei 

tullut. Se teki elämästä jossain vaiheessa aika raskastakin, 

mutta päätin että jotenkin arjen on sujuttava täällä, sillä ko-

dista en halunnut luopua. Pidän siitä että kotini on niin il-

mava ja valoisa. Kasvitkin viihtyvät täällä. Parveke on puiden 

yläpuolella ja avautuu itään, sieltä näkee maailman. Silloin 

kun muutimme, oli piha täynnä lapsia, mutta nyt niitä ei taida 

tässä talossa olla ainuttakaan. Perheet muuttavat nykyisin pois 

isompiin asuntoihin kun lapset kasvavat.

Käsityöt ovat vallanneet koko tilan. Kudin ja lankalaatikko 

ovat aina esillä – töiden pitää aina olla näkyvissä, että voi 

jatkaa kun tuntuu siltä. Ennen minulla oli kangaspuutkin tässä 

ruokapöydän kohdalla. Jokaisella tavaralla täällä on oma ta-

rinansa. Kristallikruunun oli joku jättänyt jätehuoneeseen ja 
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Sahanmäki, Mirja, 2h+k+parvi 76,5 m²

”Taidan olla oikea asukas tähän asuntoon. Muutimme tänne 1978 

Rajametsäntie 33:sta, kun lapset alkoivat tarvita omia huonei-

ta. Kolmen huoneen asunto tuntui kaksion jälkeen ihanan väljältä 

ja valoisalta, varsinkin kun olohuone on tavallista korkeampi. 

Edellisellä asukkaalla oli flyygeli tässä keskellä olohuonetta. 

Poika ja tytär saivat omat huoneet ja meidän vanhempien vuode-

sohva oli olohuoneessa parviportaan alla. Kattoterassi pyykin-

kuivausta varten oli tuossa vieressä. Poikani oli jo nuorena 

kiinnostunut tähtitieteestä ja istui iltaisin usein siellä kau-

koputkensa kanssa. Jossain vaiheessa kattoterassit kuitenkin 

rakennettiin umpeen ullakkotiloiksi, terassi taisi vuotaa. 

Koko talo remontoitiin 1994, ja silloin korvattiin kylpy-

ammeet suihkuilla, uusittiin parvekkeet ja keittiöt sekä maa-

lattiin kaikki pinnat. Huonosti, koska katosta maali irtoilee. 

Tuon porraskaiteen punotun köydenkin remonttimiehet olivat 

poistaneet, mutta minä vaadin että se on laitettava takaisin 

juuri samanlaisena. 
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VI Villinkaunis hirviön pää
 Pikku Huopalahden terassitalo
 Punamäenpolku, Pikku Huopalahti, Helsinki

 Reijo Jallinoja, 1989–1994

”Pikku Huopalahden terassitalon ohi ajaessani olen aina ajatellut että tuossa on Helsingin 
rumin talo. Talossa yhdistyvät epäarkkitehtuurin kauhukuvat, mitä maallikko voi kuvitella 
– ennen kaikkea rumuus, joka näkyy kauas!” 
Eino Laine, Helsinki HS 25.5.1994
”Olen ajatellut rakennuksia pieninä universumeina, joilla on oma koodisto, historia ja 
tulevaisuus. Rakennukset kertovat katsojalle oman tarinansa, joka toivottavasti jää muistiin 
ja muodostaa mielikuvan, minkä pohjalta hahmotamme ympäristöämme. Jos identiteettiä 
on tarpeeksi, rakennus alkaa elää omaa elämäänsä ja samalla suunnittelijan ja aikakautta 
tyylittävän maailmankuvan merkitys vähenee. Parhaassa tapauksessa rakennuksesta 
muodostuu persoonallisuus.” 
Reijo Jallinoja 199375 

Terassitalossa jo yhdeksän vuotta asunut Eric kertoo, että heidän suosikkipaikkansa kotona on 
terassi. Asunnon sisäosien tavallisuudesta huolimatta ikkunoista ja terassilta joka suuntaan au-
keava kaupunkinäkymä ilahduttaa aina uudestaan. Taivas on koko ajan näkyvissä, myrskyrintamat 
ja auringonlaskut silmien edessä. Kun muu kaupunki on jo varjossa, niin terassille aurinko vielä 
paistaa.

Terassitalon persoonallisuus on käynyt asukkaille vuosien varrella tutuksi ja kulmikkaine 
piirteineenkin jollain tavalla rakkaaksi; talon asukkaat kertovat siitä kuin hieman hankalasta 
ikääntyvästä sukulaisesta, joka kuitenkin on kiistatta merkkimies. 

Heidän tarinoissaan terassitalolla on kaksi erilaista ulottuvuutta. Vuoren mittakaava, jossa 
muu kaupunki on jalkojen alla ja horisontissa näkyvät lähestyvät myrskyrintamat ja toisaalta 
arjen, tavallisen talon mittakaava, jossa on vuosien varrella nuhjaantuneet muovimatot, vinot 
kipsilevyseinät ja persikanväriset hissit. Rakennuksessa on ajan patinaa, mutta ei vielä ihan niin 
paljon, että se herättäisi ihastusta tai nostalgiaa. Mutta vaikka terassitalo on kiistatta alkanut elää 
omaa elämäänsä kuten arkkitehdin toive oli – joko arkkitehtuurinsa tai pelkän suuren kokonsa 
ansiosta – niin ainakaan vielä ”aikakautta tyylittävän maailmankuvan merkitys” ei ole vähentynyt. 
Vaikka rakennuksen arkkitehdin Reijo Jallinojan mielestä terassitalon luonne viittaa epämääräi-
seen, mutta luonteeltaan teknis-romanttiseen tulevaisuuteen,76 niin tuntuu se nyt tarkastellen 
ennen kaikkea 1990-luvun vaihteen arkkitehtuurilta. Ehkä juuri sen aikoinaan tulevaisuuteen 
viitannut symboliikka, muoto ja kuvioinnit kiinnittävät sen erityisen tukevasti sen synnyttänee-
seen aikakauteen, sen tyyleihin ja maailmankuvaan, vaikka se on ensi silmäyksellä silmiinpistävän 
erilainen kuin useimmat konservatiivisemmat aikalaisensa. 
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sisätilaan ulkoseiniin leikatuista, selkeistä aukoista ja valaisee tilaa tasaisesti, 
kun barokin kirkkotilassa valon lähteet kätkeytyvät seinistä ulos työntyvien pyl-
väikköjen katveeseen ja valo lankea vaihtelevalla tavalla pylväs- ja seinäpinnoille 
ja antaa niille eloa ja loistoa. 

Kätketystä valonlähteestä epäsuorasti tilaan lankeava valo on Berninin 
kappeleiden Theatrum Sacrumin, ”pyhän näytöksen” tärkein tehokeino. Asamin 
veljekset, Berninin taitavimmat seuraajat, vievät nämä valotehot äärimmilleen 
kirkkojensa alttaritiloissa. Myöhäisbarokin sisätiloissa monivaippaiset ulko- ja 
sisäseinät on muovattu, koverrettu ja kuperrettu niin, että päivänvalo suorastaan 
hivelee eri pintoja. Saadaan valoa tilaan, ja tila muuttuu valoksi. 

Kuva 77. Renessanssin ihanteellinen kirkkotila, Santa Maria della 
Consolazione Todissa, 1508–. Valo lankeaa tasaisesti tilaan julki-
sivuun yksikertaisesti leikatuista aukoista.
Kuva 78. Pietro da Cortonan Santi Martina e Lucan kirkkotilassa 
Roomassa (1635–) sivuseinien kätketyt päivänvalolähteet muo-
vaavat dynaamisesti vaihtelevaa tilaa.
Kuva 79. Gian Lorenzo Bernini oli Theatrum Sacrumin mestari: 
Siunattu Ludovica Albertoni lepää näkymättömästä lähteestä 
lankeavassa valossa Rooman San Francesco a Ripan kirkon 
kappelissa, 1674.
Kuva 80. Pyhä Yrjö ratsastaa esiin Weltenburgin luostarikir-
kon kuorin valohämystä. Cosmas Damian ja Egid Quirin Asam, 
1716–1723.
Kuva 81. Asamin veljesten toinen valonkäytön mestarinäytös on 
Rohrin luostarikirkossa, 1717–1725.

sance and Early Roman Baroque interiors: in the Renaissance 
church the light enters through distinct openings cut into the 
exterior walls, illuminating the space evenly, whereas in the Ba-
roque church space the light sources are obscured by colonnades 
protruding from the walls, and the light falls in a varying way 
on the column and wall surfaces, animating them and giving 
them brilliance.

Light that falls indirectly into a space from a hidden source 
was the most important effect used by Bernini in the Thea-
trum sacrum, or “sacred theatre”, in the design of his chapels. 
The Asam brothers, Bernini’s most talented successors, took 
these lighting effects to their extreme in the altar spaces of their 
churches. In the interior spaces of the Late Baroque the mul-
tiple-shell exterior and interior walls have been shaped, carved 
and made convex so that daylight almost literally caresses the 
different surfaces. Light is brought into the space, and space is 
transformed into light.

Figure 77. The Renaissance ideal church space, Santa 
Maria della Consolazione in Todi, 1508–. The light 
falls evenly into the space from simple openings cut into 
the façade.

76a. 76b. 77. 78.
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watched on. The Austrian writer Egon Friedell described the 
minuet as one of the most unusual dances in history; simul-
taneously strictly formal and graceful, marionette-like and yet 
at the same time charming. According to Friedell, life in the 
royal court was itself like a minuet, where the participants were 
supposed to know how many steps to take before making a bow, 
what trajectory the bow had to take, and how deep it had to be 
in accordance with the status of the person they were facing.2

It has been described that from the Middle Ages to the 
baroque era it was central to the identity of any individual to 
be a member of a group: the extended family, a guild, a social 
class. It was as part of a group that the human being became an 

Barokkiajan rituaaleissa jokaisella oli oma roolinsa; jokainen oli esiintyjä 
elämän teatterissa. Kun Ranskan kuningas ja kuningatar asettuivat tanssimaan 
menuettia seurasi muu hovi heidän esitystään. Itävaltalainen kirjailija Egon 
Friedell kuvasi menuettia yhdeksi historian erikoisimmista tansseista; yhtä aikaa 
ankaran kaavamaiseksi ja sulokkaaksi, marionettimaisen jäykäksi ja samalla 
hurmaavaksi. Friedellin mukaan elämä hovissa oli menuetti, jossa osallistuja tuli 
tietää, kuinka monta askelta otetaan ennen kumarrusta, minkälaisen kaaren 
tämän kumarruksen tuli muodostaa ja kuinka syvä sen tuli olla edessä olevan 
henkilön arvon mukaan.2 

On luonnehdittu, että keskiajalta barokkiin yksilön identiteetille oli keskeistä 
jäsenyys ryhmässä: laajennetussa perheessä, killassa, omassa yhteiskuntaluo-
kassa. Osana ryhmää ihmisestä tuli persoona, joka eli elämänsä ja kuoli osana 
ryhmäänsä. Ihminen, joka suljettiin pois ryhmästä, menetti kunniansa. Ihminen 
myös kuvattiin mielellään osana suurta seuruetta, julkiseksi luonnehdittavaa 
tapahtumaa, olipa kyseessä sitten karnevaalit tai juhla-ateria.3 

Ruotsalaisen historioitsijan ja kirjailijan, Peter Englundin mukaan on käsityk-
semme yksinäisyydestä osana onnellista elämää myöhäinen ja kehittynyt vasta 
nykyajan kynnyksellä; sitä ennen sopi yksinäisyys vain erakoille tai rukoushetkiin. 
Englund näkee ensimmäiset merkit ”onnellisesta yksinäisyydestä”, intimiteetin 
tarpeesta 1600-luvun vaihteessa. Silloin kuvaa madame de Sévigné tuntikausien 
yksinäistä vaellustaan kirja kädessä puutarhassa ja ruotsalaisissa viisuissa laule-
taan rakastavaisista luonnossa hakemassa pakopaikkaa lemmenseikkailuille.4 

Kodit olivatkin pitkään julkisia ja niiden tilat suuria ihmisryhmiä varten: kotona 
synnytettiin, sairastettiin ja kuoltiin mutta ei suinkaan ympäristöstä eristettynä 
vaan monenlaisen kiinnostuksen keskipisteenä – sukulaisten, naapurien ja 

Figure 4. Abraham Bosse (1602/1604–1676): 
The Bride Taken Home (La Mariée reconduite 
chez elle), 1633.

Figure 2. Unknown printmaker: Almanac for 
the Year 1682 (Le bal à la françoise), 1681, 
Publisher: Pierre Landry (French, ca. 1630– 
1701), Engraving and etching with letterpress 
calendar, Bibliothèque nationale de France, 
Département des Estampes et de la Photogra-
phie. Photo credit: BnF.

Figure 3. Unkown: Banquett at the Casa Nani 
alla Giudecca in Venice in honour of the 
Elector-Archbishop of Cologne Clemens-August 
of Wittelsbach on Septmember 9th. 1755, Ca’ 
Rezzonico, Venice - Italy.

4. 2. 3. 

Kuva 4. Abraham Bosse (1602/1604–1676): 
Morsian saapuu kotiin (La Mariée reconduite 
chez elle), 1633.

Kuva 2. Tuntematon: Vuoden 1682 almanakka 
(Le bal à la françoise), 1681, julkaisija: Pierre 
Landry (Ranska, n. 1630– 1701), kaiverrus ja 
etsaus, kalenteri kohopaino, Bibliothèque na-
tionale de France, Département des Estampes 
et de la Photographie. Valokuva: BnF.

Kuva 3. Tuntematon: Juhla-ateria, Casa Nani 
alla Giudecca Venetsiassa, Kölnin vaali-
ruhtinaan ja arkkipiispan, Wittelsbachin 
Clemens-Augustin kunniaksi, 9.9.1755. Ca’ 
Rezzonico, Venetsia, Italia.



Raamattu (Geneva Bible), 1597.



William Morris: Works of Geoffrey Chaucer, 1896.



Emigre: Emigre #11, 1989.



David Carson: RayGun, 1994.



Taiton suunnittelun perusvälineet (InDesign)

File > Document Setup	 	

Sivukoon määrittely, ovatko sivut yksittäisiä arkkeja, vai muodostavatko aukeamia (rasti kohtaan ‘Facing 

pages’), tarvittaessa leikkausvaran määrittely (Bleed).

Layout > Margins and Columns
Marginaalien määrittely, sekä palstojen (Columns) määrän ja välien (Gutter) määrittely.

Pages > Master
‘Master’ sivu on taittogridin mallisivu, joka toistuu kaikissa sivuissa. Suunnittele gridisi Master sivulle, niin 

sinun ei tarvitse tehdä joka sivulle omaa gridiä. Tarvittaessa voit tehdä useita erilaisia Master sivuja.

View > Show Rulers
Helpoin tapa luoda apuviivoja (Guides) on vetää hiirellä mittanauhan (Ruler) alueelta apuviiva sivun 

päälle, apuviivan tarkka sijainti kannattaa antaa koordinaatin muodossa.



K A R J A L A N  A R K K I T E H T I  -  А Р Х И Т Е К Т О Р  К А Р Е Л И И 

Uno   Ullberg  
Уно    Ульберг

Näyttelykuraattori / Куратор выставки

Kimmo Sarje / Киммо Сарье
Graafikko / Графическое оформление

Tommy Lindgren / Томми Линдгрен  
Käännös suomesta venäjäksi / 

Перевод с финского на русский

Jaroslava Novikova / Ярослава Новикова
Käännöksen tarkistus / Редактор перевода

Mika Mihail Pylsy / Мика Михаил Пюлсю

Rahoitus / Финансовая поддержка 

Karjalan Kulttuurirahasto sr, Helsinki / 
Карельский Фонд Культуры Хельсинки
Viipurin taloudellinen korkeakouluseura ry., Helsinki / 
Группа экономических ВУЗов Выборга
William ja Ester Otsakorven Säätiö, Lappeenranta / 
Фонд Виллиама и Эстер Отсакорпи, Лаппеенранта 

Hallinto / Правление

Suomen Pietarin instituutti, Pietari / 
Институт Финляндии в Санкт-Петербурге
Saimaan ammattikorkeakoulu, Imatra / 
Политехнический институт Саймы, Иматра
Viipurin kaupungin kirjasto, Viipuri / 
МАУК Библиотека Алвара Аалто, Выборг
Sortavalan piirin kirjasto, Sortavala / 
Сортавальская межпоселенческая районная 
библиотека, Сортавала

Tekninen toteutus / Техническое исполнение

Maxibit Finland Feelfree Oy, Helsinki, 2016
Julkaisun painatus / Печатание

Vammalan Kirjapaino, Vammala, 2016

Typografia
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a. Pistekoko
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William Caslon I (1770) ja Carol Twombly (1990): Adobe Caslon.
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Sanomalehtiin ja pienessä koossa luettaviksi tarkoitetuissa tyypeissä (esim. Times New Roman) 

x-korkeus on suurempi kuin otsikkokäyttöön tarkoitetuissa (esim. Perpetua).

Riviväli (leading)
Riviväli määritellään myös pistekokona. Hyvä nyrkkisääntö 120% riviväli suhteessa pistekokoon. 

Esim. pistekoko 12, riviväli 14,4. Kirjasintyypin x-korkeus vaikuttaa myös optiseen riviväliin - suuren 

x-korkeuden tyypeissä sama riviväli vaikuttaa pienemmältä kuin pienen x-korkeuden kirjasimissa.

Kirjainväli (kerning) ja ligatuurit
Huolella suunnitellut kirjasintyypit määrittävät kirjainparien välin, eikä kirjainväliä usein tarvitse säätää, 

osa kirjainpareista muodostaa ns. ‘ligatuureja’ eli yhdistelmiä. 



Ohjeita kirjasintyypin määrittelyyn

Pistekoko	 	

Pistekoko ei kerro kirjasintypin optisesta koosta - x-korkeus voi vaihdella tyyppien välillä paljon. 

Sanomalehtiin ja pienessä koossa luettaviksi tarkoitetuissa tyypeissä (esim. Times New Roman) 

x-korkeus on suurempi kuin otsikkokäyttöön tarkoitetuissa (esim. Perpetua).

Riviväli (leading)
Riviväli määritellään myös pistekokona. Hyvä nyrkkisääntö 120% riviväli suhteessa pistekokoon. 

Esim. pistekoko 12, riviväli 14,4. Kirjasintyypin x-korkeus vaikuttaa myös optiseen riviväliin - suuren 

x-korkeuden tyypeissä sama riviväli vaikuttaa pienemmältä kuin pienen x-korkeuden kirjasimissa.

Kirjainväli (kerning) ja ligatuurit
Huolella suunnitellut kirjasintyypit määrittävät kirjainparien välin, eikä kirjainväliä usein tarvitse säätää, 

osa kirjainpareista muodostaa ns. ‘ligatuureja’ eli yhdistelmiä. 

f i = fi, f f = ff, f l = fl

Claude Garamond (1500-l) Robert Slimbach (1989): Adobe Garamond.



Kirjasintyyppien luokittelu perustuu jakoon niiden ominaisuuksien mukaan, pääasialliset erot liittyvät 

kirjainten suuntaukseen, käytettyjen linjojen paksuuskontrasteihin ja päätteiden artikulointiin. 

Yleinen jako voidaan tehdä latinalaisiin, ei-latinalaisiin ja goottilaisiin tyyppeihin. Latinalaisissa 

kirjasintyyleissa taas suurimmat ryhmät muodostavat päätteelliset (Serif) antiikvat, sekä päätteettömät 

(Sans serif) groteskit. Nämä kaksi ovat julkaisun suunnittelussa käytettävät pääasialliset tyyppiryhmät. 



Serif

	 Humanistiset, 1400-l

	 Garaldiset, 1500-1700-l

	 Barokki, 1700-l

	 Klassiset, 1700-l

	 Egyptienne, 1800-l

	

	

Centaur, regular

Adobe Garamond, regular

Adobe Caslon, regular
Bodoni, regular

Rockwell, regular

	

	

	

Franklin Gothic, regular

Helvetica, regular

Bank Gothic, regular

Gill Sans, regular

	

	

	

Sans serif

	 Perusgroteskit, 1800-l

	 Uusgroteskit, 1900-50-l

	 Geometriset groteskit, 1920-l

	 Humanistiset groteskit, 1920-l

	

a a



Kirjasintyyppien perheet

Kirjasintyypin perheen muodostavat sen kaikki eri leikkaukset - näitä ovat tyypillisesti perusleikkaus, 

usein nimeltään regular, roman, medium, book tms., sekä erityistarkoituksiin suunnitellut italic, tai kursiivi 

ja bold, tai lihavoitu. Näiden lisäksi kirjasintyypin perheeseen voi kuulua sen leveyteen vaikuttavia 

erikoisleikkauksia kuten thin, condensed, wide yms.

Tärkeintä kirjasintyyppiä valitessa on kuitenkin, että se mahdollistaa riittävän määrän erilaisia painotuksia 

leikkauksiensa puitteissa - monissa kirjasintyypeissä, joiden perusleikkaus on erikoinen, voi olla pieni 

tai olematon valikoima leikkauksia - ennen valintaa, käy mielessäsi läpi millä kaikilla tavoin haluat 

kirjasintyyppiä käyttää.

William Caslon I (1770) ja Carol Twombly (1990): Adobe Caslon.
regular, semibold, bold, italic, bold italic

a a a a a



Typografian määrittelyn välineet (InDesign)

Type > Paragraph Styles	 	

Määrittele käyttämäsi kirjasintyypit aina käyttämällä tyylejä - Paragraph Styles-kohdan avulla voit 

määritellä tyylin, jota sovellat aina kokonaiseen kappaleeseen (eli rivinvaihdosta rivinvaihtoon). Muista 

määritellä käytetty kieli (koskee tavutusta), käytetäänkö ligatuureja vai ei ja tasaus. 

Type > Character Styles	
Character Styles-kohdan avulla voit määritellä tyylin, jota sovellat aina vain valitsemiisi kirjaimiin tai 

sanoihin. 

Ohjeita tyylien käyttöön 
Tee valmiiksi joukko tyylejä eri tilanteisiin, muokkaa yksittäisiä sanoja vain poikkeustapauksissa.

Jos tyylin perässä on ‘+’ merkki, tarkoittaa se sitä, että valitsemassasi kohdassa tyyliä on muokattu - 

palauttaaksesi kappaleen tyylin mukaiseksi, klikkaa tyyliä ‘alt’ näppäin pohjassa. 



Kuvankäsittely

Mies van der Rohe: Barcelona paviljonki, 1929.



Kuvien käytössä ja käsittelyssä oleellista on 

1. niiden lähde ja tyyppi - onko kuva digitaalinen valokuva, skannattu valokuva painetusta kirjasta, tai 

esim. skannattu alkuperäinen piirros; ja 

2. missä koossa ja miten kuvaa tullaan käyttämään - kuvan lopullinen koko ja käytetyn median tarkkuus 

ovat merkittäviä tekijöitä kuvan käsittelyn tavoitteita asetettaessa. 



Ohjeita koskien kuvan lähdettä (Photoshop)

Pyri aina käyttämään kuvaa samankokoisena tai pienempänä kuin sen alkuperäinen koko. 

Skannatun piirroksen käytössä häivytä halutessasi paperin sävy esim. levels-säädöillä.

Image > Adjustment > Levels/Curves
Komento mahdollistaa kuvan sävyalueen muokkaamisen, valitsemalla kuvan vaalein piste voidaan 

häivyttää esimerkiksi skannatun kuvan paperin sävy.



Mies van der Rohe: Barcelona paviljonki, 1929.







Ohjeita koskien kuvan lähdettä (Photoshop)

Kirjasta skannatun kuvan käytössä, tai rasteroidun kuvan käytössä vältä moiré-kuvioita joko käyttämällä 

kuvia bitmap-muodossa, tai häivyttämällä rasterointi esim. blur-filtterillä.

Filter > Blur > Gaussian Blur
Komento mahdollistaa painetun rasteripisteen häivyttämisen sumentamalla kuvaa mahdollisimman vähän, 

niin, että rasteroinnin kuvio häviää, eikä johda moiré-kuvioihin tulostettaessa tai painettaessa.









Ohjeita koskien kuvan käyttöä (Photoshop)

Kuvan koko ja käytetty media (tulostus, paino, näyttö) määrittävät tarvittavan resoluution. Resoluutio 

määritellään yleensä muodossa ‘pistettä tuumaa kohden’ - dpi - harvemin käytetään ‘pistettä senttimetriä 

kohden’ - dcm - joka on käytännössä sama asia, mutta 1/2.54 kertaisena.

Media- ja tekniikkakohtaiset resoluutiot
Näyttöresoluutio: yleensä 72 dpi tai 92 dpi

Värikuvassa: 200 dpi ok tulostukseen, 300 dpi painotuotteeseen.

Mustavalkoisessa harmaasävykuvassa: 200 dpi ok tulostukseen, 400 dpi painotuotteeseen.

Mustavalkoisessa bittikarttakuvassa: 600 dpi ok tulostukseen, 1200 dpi painotuotteeseen.

Resoluutio määritellään kohdassa Image > Image Size





Piirrokset, kaaviot

Ludwig Hilberseimer: The New City, 1944.



Piirrokset, kaaviot, yms. materiaali muodostaa usein merkittävän osan arkkitehtuuria tai maisema-

arkkitehtuuria käsittelevien julkaisujen kuvista. Varmistuakseen kuvien laadusta, on hyvä noudattaa 

muutamaa yleistä ohjetta: 

Piirrokset
Pääosin piirrokset on aina hyvä esittää 1200 dpi resoluution bittikarttakuvina, cad-kuvat voi siirtää taittoon 

esimerkiksi ensin tulostamalla ne oikeilla viivanpaksuuksilla pdf-tiedostoksi, ja sitten avaamalla pdf-tiedostot  

Photoshopissa ja tallentamalla bittikarttakuvina .tiff muotoon. 

Värillisiä ja sävykkäitä piirroksia voi käsitellä kuten väri- tai harmaasävyvalokuvia.
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Rajametsäntie, Maunula, Helsinki

Hilding Ekelund, 1951-1956

Asuntopohja 1:100

52

Pohja 1. kerros (ylh.) 1:200 Leikkaus (alh.)  1:200

Sanna Meriläinen: Tavallisia koteja, 2016.



Kaaviot
Toteuta kaaviot jos mahdollista InDesign tai Illustrator ohjelmilla vektori-grafiikkana, eli käyttämällä 

ohjelmien piirrostyökaluja, vektorit eivät menetä tarkkuuttaan rasterikuvien tavoin, vaikka niitä suurentaisi 

tai muuten käsittelisi. Jos kaaviokuvan lähteenä on piirros, niin se olisi hyvä käsitellä kuten edellisessä 

kohdassa, 1200 dpi resoluution bittikarttakuvana. 
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Yhteenveto 



Sivukoot
Pohdi lukutilannetta ja sisältöä - näiden tasapaino 

määrittää julkaisun sivukoon ja sidonnan.

B5 on hyvä yleiskoko sivuille joilla tekstiä ja kuvia, 

A5 pelkälle tekstille ja A4 ja sitä suuremmat 

runsaalle kuvamäärälle. Pystysivu on hyvä 

yleisvalinta, vaakasivut jos kuvamateriaali niin 

vaatii, eikä tekstiä ole paljon. 

Taitto
Muista riittävät sisämarginaalit, huomioiden 

sidosasun ominaisuudet (jäykkyys). Palstojen 

avulla voidaan hallita tekstiä, mutta myös luoda 

hierarkioita ja suhteita sisältöjen välille. 

Kirjasintyypit
Valitse kirjasintyypit tarkoituksenmukaisesti, pohdi 

tarvitsetko useita leikkauksia samasta tekstityypistä, 

jolloin uniikki tekstityyppi ei ole sopiva.

Koetulosta aina tekstisivuja - pistekoot ovat 

tyyppikohtaisia.

Kuvien resoluutio
Näytöllä 92 dpi riittävä resoluutio.

Tulostuksessa riittää yleensä 200 dpi sävykuvissa, ja

600 dpi taas bittikarttakuvassa.

Painotuotteessa värikuva 300 dpi,

harmaasävykuva 400 dpi ja

bittikarttakuva 1200 dpi.




